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Overvi ew 

Overview 
Small Tool Track ing is a program designed to maintain a l ist  of tools and to assign them to the 
employees, t rucks, job sites, warehouses, tool boxes, and other locat ions responsible for  the 
care of the tools.  By mak ing tool users accountable for  their  tools, an organizat ion can save 
substant ially by reassigning or  repair ing tools rather  than pu rchasing new ones. 

The tools are subdivided into classes for  organizat ional pu rposes.  For  example, you  may have 
a tool class called Saws with specific tools with in that  class such as circu lar  saws, j ig saws, 
chain saws, and concrete saws.  Tools can also be assigned to a k it  if you  always check  ou t a 
group of tools together. 

Users are individuals who are responsible for  cer tain tools in your tool inventory.  A user may 
be a person, a t ruck , a tool box, or  whatever is appropr iate for  your business.  In the setup 
screen, you  can actually specify the program's terminology to su it  you r needs.  For  instance, 
you  may change the User label to Truck  if that  is more appropr iate for  your use.  You  may also 
set up sites to which you  can assign tools.  These sites may be long term job sites or  satell ite 
offices of your main office.   

With the Tool List , User List , and Site List  in  place, you  can Check  Ou t tools to users and/ or  
sites.  The tool is assigned to the user and an entry is made in the Tool History fi le.  Reports 
can be done By Tool, By User, or  By Site so you  can see who has which tools and also where 
the tools have been assigned.  Tools can then be Checked In once a User is fin ished using the 
tools.   



 

2  ····   Get t i ng St ar t ed Landm ark  Dat a Syst em s, Inc. Sm al l  Tool  Track i ng 

 

Get t i ng St ar t ed 

Get t i ng Help 
There are several ways, listed below, to receive help with the Small Tool Track ing program.   

·  Pr inted Documentat ion sent with the software. 

·  Help menu  at  the top of the Small Tool Track ing Program. 

·  Help bu tton on the side bar while in any screen in the software will give you  help on a 
part icu lar  funct ion. 

·  Go to ou r  web site at  www.landmarkdata.com and select  Online Support .  You  can also 
go direct ly to that  site by choosing Online Support  from the Help Menu . 

·  Email us at  support@landmarkdata.com or select  email Landmark  in the Help Menu . 

·  Call us at  1(800)424-8178. 

Defi n i ng Tool  Classes 
The first  step in using the Small Tool Track ing program is to set  up tool classes.  Enter ing 
classes into the Class list  is explained in more detail later  in th is manual.  These classes are 
used to divide the tools into broad categor ies for organizat ional pu rposes.  Be specific in 
assigning Tool Classes.  A few broad categor ies may not be as helpfu l as more detailed ones.  
Your l ist  may look  like th is. 

 

 CLASS  TOOL ID DESCRIPTION 

 circsaws Sk il-9382 Sk il 6" circu lar  saw 

 circsaws Sk il-9328 Sk il 8" circu lar  saw 

 circsaws B&D9832 Black  &  Decker 8" circu lar  saw 

 

 chainsaws P930243 Pou lan 18" chain saw 

 chainsaws S49X933 Homelite 16" chain saw 

 

 j igsaws  BD9303 Black  &  Decker j ig saw 
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 j igsaws  MIL903 Milwaukee jig saw 

 

Organ i zi ng Tools 
Once you  have entered your tool classes you  may begin enter ing your Tool List .  The Tool List  
is the master  l ist  of tools owned by the company.  Enter ing and edit ing tools in the Tool List  
wil l be explained in more detail later in th is manual.  The Tool List  allows you  to define each 
tool in  your inventory and assign it  an individual Tool ID.  In the Tool List  you  will assign the 
tool to the part icu lar  Class, discussed in the previous sect ion, to which it  belongs.  Also you  
have the abil ity to enter  the ser ial number, manu factu rer , vendor, pu rchase date, warranty 
informat ion, and more abou t the tool to help you  ident ify it .  With the Tool List  you  are able to 
add a pictu re of the tool for  easier  recognit ion.  You  may enter  as much or  as lit t le informat ion 
abou t the tool as needed to organize and ident ify your tool inventory.   

 

Bar  Coding 
Bar coding your tools is an opt ional par t  of the Small Tool Track ing software.  You  have the 
abil ity with the Small Tool Track ing software to assign a bar code ID to some or  all of you r 
tools.  The program supports corded and cordless bar coding scanners.  To receive a list  of 
supported bar code scanners contact  Landmark  Data Systems, Inc.  Bar coding provides 
another way to ident ify and organize your tools.  Scanning bar codes provides a more 
convenient method to check-in or  check-ou t your tools. 

 

Organ i zi ng Users 
The User List  is a simple list  of the individuals, t rucks, tool boxes or  other  places where the 
tools may be checked ou t.  Enter ing and edit ing users in the User List wil l be explained in more 
detail later  in th is manual.  The User List  allows you  to enter  a unique User ID for  each user.  
You  can also enter  the users name, address, phone number, fax number, email address, 
supervisor , and other informat ion that will allow you  to ident ify and organize the User List . 

 

Organ i zi ng Si t es 
The Site List  is a simple list  of the job sites, satell ite offices, or  other  places where tools are 
assigned.  Enter ing and edit ing sites in the Site List  wil l be explained in more detail later  in 
th is manual.  The Site List  allows you  to enter  a unique Site ID for  each site.  You  can also 
enter  the name, address, phone number, fax number, supervisor , and other informat ion that 
will allow you  to ident ify and organize the Site List . 

 

Organ i zi ng K i t s 
Tool Kits are collect ions of tools that may be treated as a single unit .  Enter ing and edit ing tool 
k its in the Kits List  wil l be explained in more detail later  in th is manual.  For  example, you  may 
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have a toolbox which includes a hammer, screwdr iver , pliers and flashlight .  While each tool 
must be listed in the Tool List , it  may be associated with a Kit  and checked ou t and in by 
referencing the Kit  ID rather  than each individual tool.  After  creat ing the tool k its you  must 
use the Kit  Assignment tab to assign tools to the k its. Enter ing and edit ing k its in the Kit  
Assignment tab will be explained in more detail later  in th is manual.  Tool Kits may be bar 
coded just  l ike Tools. 
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Inst al lat i on  

Inst al l i ng t he Program  
 

Find the Small Tool Track ing CD and place it  in  the CD dr ive.  The install program shou ld 
au to-star t . If it  does not, use Windows Explorer  to navigate to your CD dr ive and double-click  
on the AUTORUN.EXE program in the CD root directory.  Follow the instruct ions.  If in  doubt, 
accept the defau lt  value offered. 
 
On the splash screen select  Install Program.  Make su re no one is using Small Tool Track ing 
while you  perform the installat ion.  The program will show the following screen. 
 

 
 

Single User  

For users that  have Small Tool Track ing only on one computer , click  on the Single User 
Installat ion and follow the instruct ions.  When the program installat ion has completed, go into 
Small Tool Track ing and allow it  to update the database if necessary. 

Peer -t o-Peer  Net work  
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In a Peer-to-Peer network  there is not a dedicated server  bu t rather  a workstat ion that also has 
the database running on it .   
 
First  install the Peer -t o-Peer  Server  on the machine that will host  the Small Tool Track ing 
database.  Select  the Install Server  bu tton under the Peer-to-Peer Network  sect ion of the install 
screen.  Follow the onscreen instruct ions.  Be su re to reboot the server  after  Small Tool 
Track ing has been loaded. 
 
This also installs the Network  Client  on th is workstat ion.  This workstat ion will have a red SQL 
icon displayed in the icon tray in the lower r ight  corner of the screen. 
 
Now install the Network  Client  on all remaining workstat ions. 
 

Dedi cat ed Server  Net work  
 
To install Small Tool Track ing on a dedicated server , select  the Install Server  bu tton under the 
Client / Server Network  port ion of the install screen.  A window will pop up ver ifying that you  
are install ing the server  por t ion of the software.  The program will install au tomat ically.  It  may 
take several minu tes depending on your system.  After  the program has installed a window will 
pop up tell ing you  to restar t  the server .  After  the server  has rebooted you  must set  up the 
Small Tool Track ing database service.  Select  the Star t  bu t ton at  the bottom of the screen, 
select  All Programs, select  SQL Anywhere 9, and click  Sybase Central.  You  will see the 
following screen. 
 

 
 
Please select Adapt ive Server Anywhere 9 in the screen on the left .  Then select  the Services tab 
on the r ight  and press the new services bu tton above the Folders screen.  After  you  press the 
New Services bu tton a window will pop up allowing you  to configu re your Small Tool Track ing 
Database service.  You  will see the following screens. 
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On the first  screen, enter  ST32 as the name of the new service.  Click  next and you  will see the 
following screen. 
 

 
 
Select  Network  Database Server and click  next.  You  will see the following screen. 
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Leave the data path as the defau lt  unless you  have installed the database into a different 
directory.  If you  have installed the database into a different locat ion use the browse bu tton to 
select  the dbsrv9.exe fi le.  Then press next and the following screen will appear. 
 

 
 
Type the parameters in the white box on the screen above into the white box on your screen.  
Be carefu l to type the parameters exact ly as shown.  Press the next bu tton and the following 
screen will appear. 
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Make su re Local system account is selected.  Also make su re the allow service to interact  with 
desk top box is uncheck ed.  This box is checked by defau lt .  Press the next bu tton. 
 

 
 
Select  Au tomat ic on the service startup screen and press the next bu tton. 
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Check  the Star t  the service now box and click  Fin ish. 
 
Next install the Net work  Cl i en t  on each workstat ion by inser t ing the CD in each workstat ion, 
allowing the installat ion program to star t , click ing on Network  Client  and following 
instruct ions. 

 

 

Syst em  Set up 
Click  on File, then System Setup. 
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This window is used to personalize the program for  your company. The labels for  User, Tool, 
Class and Kit  are provided for  you  to change the nomenclatu re in the program.  For example, 
you  may wish to use Job Site in place of User.  By changing th is label, the term Job Site will 
appear in place of User in all windows and on all pr intou ts. 

The Database sect ion indicates version informat ion abou t the cu rrent database in use and the 
licensed and cu rrent user connect ions. 

The Country Sett ings sect ion allows you  to select the type of cu rrency you  wou ld like the 
program to use.  It  also provides a space to set  the format for  the date. 

The Data Backup sect ion provides a place to set the defau lt  data path for  the Backup locat ion.  
This path will appear in the dest inat ion directory of the DB Backup screen.  

The last  sect ion gives you  an opportunity to enter  a specially provided unlock  code to release 
all featu res of the program mak ing it  a fu ll work ing copy rather  than a demo.  Upon enter ing 
an acceptable unlock  code, the words "(Demo version)" will disappear from the t it le capt ion 
Small Tool Track ing. 

This unlock  code is provided by Landmark  upon receipt  of payment.  The Registrat ion Code is 
uniquely defined for  each installat ion of the program and the installat ion date is available for  
reference. 

 

 

Com pany Set up 
 

Click  on File, then Company Setup. 
 

 
 
In it ially, the company listed as CO# 1 will display with the name “New Company.”  You  will 
change th is entry to your company by enter ing your company’s informat ion in the Com pany 
Nam e, Address, Phone, and Fax fields.   
 
The Pr inter  Sett ings are used to adjust  the locat ion of the pr int  area on pre-pr inted documents.  
The defau lt  values of 0.500 inches shou ld be fine for  most pr inters; however, if you  need to 
move the pr int  more to the r ight , increase the Left  Margi n .  Likewise, if you  need to move the 
pr int  down on the page, increase the Top Margin .  To move left  and up, decrease the left  and 
top margins, respect ively. 
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If you  wish to use user names and passwords in order to control which employees have access 
to the Small Tool Track ing system, click  on the Users/ Passwords box to place a check  mark  in 
it .  You  may add more users.   
 
Click  on the check  mark  bu tton in the List  Navigator  to post th is informat ion.  If necessary, 
you  may add more companies to th is l ist .  To access a company’s database while work ing in a 
different company’s database, simply click  on File, then Open Company.  Select  the desired 
company using the drop-down menu and click  the OK bu tton. 
 

Set  Up Syst em  Users (opt i onal ) 
 
In the Company Setup screen, make su re the Users/ Passwords box has a check  mark  in it , 
indicat ing the featu re is enabled. Click  on the Users bu tton to open the User Profile screen.  
Every company has a user called SYSTEM with  the defau lt  password LANDMARK.  This user 
name and password give you  access to the User Profiles screen, where employees are assigned 
a password and given a user status.   
 

 
 
 
Click  on the plus bu tton to inser t  an entry into the user l ist .  In the User  ID column, enter  an 
ident ificat ion reference (e.g., last  name and first  in it ial) for  each employee.  Enter  the 
employee’s name in the Nam e column.  Save the entry by click ing on the check  mark  bu tton or  
by tabbing to the next row.  Repeat th is process unt il all employees are entered.   
 
Select  an employee and enter  h is or  her  password in the Password field.  Leave the field blank  
if you  do not want to assign a password.   
 
To select  the modu les to which the employee will have access, click  on the Permissions tab.  A 
check  mark  in the box next to a modu le indicates the user will have access to that  modu le.  To 
uncheck  a box, indicat ing the employee will not  have access to the box’s corresponding 
modu le, double-click  on the box.   
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Im plem ent at i on  Task s 

Class Li st  
 

A Class is a subdivision of tools into broad categor ies for  organizat ional pu rposes.  Be specific 
in assigning Tool Classes.  A few broad categor ies may not be as helpfu l as more detailed ones.  
An example of the Class List  screen is shown in figu re 1.  To add a new Class press the “+” 
symbol and fi l l  in  the appropr iate fields.  The Class List  fields are explained below figu re 1. 

 
Figure 1 

 

Class ID Enter  a unique ID number for  the class.  This ID will be used to assign 
tools to each Class. 

Descr i pt i on  Enter  a descr ipt ion of the Class to fu r ther  ident ify it . 
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Vendor  Li st  
You may add new vendors here by enter ing a Vendor ID, name, address and other informat ion 
abou t the vendor.  The vendor l ist  is used in the Tool Setup to select  manu factu rer  and vendor 
values.  It  is also used in the Repair / Maintenance screen to select  a vendor value.  The vendor 
l ist  is an opt ional par t  of the Small Tool Track ing program and is not requ ired to setup your 
tool l ist .  Once you  add th is vendor, it  is immediately available for  select ion from the vendor 
l ist .  An example of the Vendor List  screen is shown in figu re 2.  To add a new Vendor press the 
“+” symbol and fi l l  in  the appropr iate fields.  The Vendor List  fields are explained below figu re 
2. 

 

 
Figure 2 

 

Vendor  ID A unique ID number to ident ify the Vendor.  This ID will be used to 
assign tools to specific Vendors. 

Nam e   Enter  the Name of the Vendor. 

Address  Enter  the Address of the Vendor. 

Phone   Enter  the phone number of the Vendor. 

Fax   Enter  the fax number of the Vendor. 

Em ai l  Address Enter  the email address of the Vendor if applicable. 

Con t act   Enter  the Contact  person for  the Vendor. 

 

You  also have the abil ity to setup a Vendor using the Qui ck  Vendor  Set up.  When sett ing up a 
tool and when enter ing data into the Repair / Maintenance screen you  have the abil ity to use 
the Qu ick  Vendor Setup.  Press the “…” bu tton under the select  a vendor or  manu factu rer  and 
a window will pop up allowing you  to select  a vendor from a list .  While on th is screen press the 
“setup” bu tton on the Task  Bar to enter  the Qu ick  Vendor Setup.  Then enter  the Vendor ID 
and other informat ion to qu ick ly setup a new vendor.   
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Tool  Li st  
The Tool List  is the master  l ist  of tools owned by the company.  Pr ior  to enter ing th is 
informat ion, you  shou ld have entered the Class List .  If you  are going to add vendors or  
manu factu rers to fu r ther  define your tools you  shou ld also have the Vendor List  setup before 
adding tools.  The gr id l ist  at  the left  of the screen is used to easily select an item for  viewing or  
edit ing.  Enter  or  change data in the field to the r ight  of the screen only.  An example of the 
Tool List  screen is shown in figu re3.  To add a new Tool press the “+” symbol and fi l l in  the 
appropr iate fields.  The Tool List  fields are explained below figu re 3. 

 

 
Figure 3 

 
Tool  ID Enter  a unique ID number for  the tool.  This number shou ld be assigned 

to easily ident ify the tool from its physical appearance. 
 
Class ID Select  the tool class from the previously entered list  by click ing on the 

down arrow at  the r ight  of the entry box. 
 
Descr i pt i on  Enter  here a descr ipt ion of the tool such as 8" Dewalt  circu lar  saw. 
 
Bar  Code ID This is an opt ional field for  use with the Bar Code scanning featu re of the 

program.  Enter  a unique Bar Code number either  by manually typing 
the Bar Code number or by select ing the field and then scanning the Bar 
Code with the Bar Code Scanner.  This ID number will be used to ident ify 
the tool when check ing in and ou t tools.  

 
Ser i al  Num ber  Enter  here the tool's ser ial number. 
 
Manufact urer   Enter  here the manu factu rer  of the tool. 
 
Vendor  Enter  here the name of the vendor from whom the tool was pu rchased. 
 
Purchase Dat e Enter  here the pu rchase date.  You  can use the down arrow at  the r ight  

of the entry box to pu ll up a calendar to pick  a date. 
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War ran t y   Enter  here the tool warranty in months. 
 
Inven t ory  If th is tool is an inventory item that you  keep in stock  check  th is box.  If 

you  check  th is box you  will also need to enter  the quant ity of the item 
you  have in stock .  Also enter  how the quant ity of the item is measured 
and the cost per  measurement.   

 
Load Pi ct ure This bu tton allows you  to add a pictu re of the tool for  easier  

ident ificat ion.  After  click ing th is bu tton a window will open allowing you  
to browse to the pictu re fi le on you  computer  or  at tached device.  The fi le 
types must be either  a jpg, jpeg, or  bmp. 

 
Erase Pi ct ure This bu tton will appear after  you  have added a pictu re to the tool.  This 

bu tton allows you  to delete the pictu re of the tool you  have previously 
added. 

 
Not es Make notes here abou t the tool.  These may be updated per iodically to 

bu ild a diary of in format ion abou t the tool. 
 
 
The tool l ist  screen also gives you  the abil ity to clone a tool, pr int  the tool l ist , and pr int  bar  
code labels.  You  will see these bu ttons on the r ight  side of the screen in the Task  Bar.   
 
If you  have several tools that  are of the same type and you  do not wish to enter  each tool 
individually you  may clone the tool.  Enter  the informat ion for  the first  tool and then press the 
Clone But t on .  A window will pop up, enter  the Tool ID for the new tool and press the “Clone 
It ” bu t ton.  The program will create a new tool with the new Tool ID you  entered and exact ly the 
same data as the cloned tool except for  the Tool ID, Barcode ID, Due Date, and the notes.  
Repeat these steps to create the remaining cloned tools. 
 
Using the pr int  bu t ton on the Task  Bar, you  may pr int  ou t  the ent ire tool l ist  or  a specific 
sect ion of the tool l ist .  You  can also sor t  the list  in  a var iety of ways.  When you  select  th is 
opt ion a window will pop up allowing you  to customize the report .  Use the drop down arrows 
next to the select ion field to select  which field to sor t  by.  Then use the drop down arrow to 
select  which field you  wou ld like to use to select  the tools to report .  Once you  have selected 
which field you  want use the drop down arrows to choose the range of tools you  wish to include 
in your report .  After  you  have made your select ions press the “Pr int  It ” bu t ton to display the 
resu lts of you r report .  You  may pr int  th is resu lt  screen by select ing the pr int  bu t ton in the top 
left  hand corner of the report . 
 
Addit ionally you  have the abil ity to pr int  you r own Barcode Labels.  Using the Barcode bu tton 
on the Task  Bar you  can design and pr int  you r own Barcode Labels.  The Barcode label window 
will display a text  box that will pr int  on your labels.  The text  box will display your company 
name and phone number by defau lt .  Click  in the text  box to type the informat ion you  wou ld 
like to appear on the Barcode Labels.  Right  click  in the box to br ing up a menu  that will allow 
you  to change the font style, font  size, add a logo, and other opt ions.  After  you  have entered 
the information you  must enter  the ser ial numbers for  the Barcodes.  This must be a number.  
You  can not enter  decimals, dashes, alphabet characters, or  any other symbols.  Then enter  
the number of labels to pr int  and press the Pr i n t  bu t ton.  The Barcodes are designed to pr int  
on Avery 5510 labels.  You  can also save your design in order to pr int  more bar codes later . 
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User  Li st  
The User List  is a simple list  of the individuals, t rucks, tool boxes or  other  places where the 
tools are assigned.  An example of the User List  screen is shown in figu re 4.  To add a new User 
press the “+” symbol and fi l l  in  the appropr iate fields.  The User List  fields are explained below 
figu re 4. 

 
Figure 4 

 

User  ID  A unique ID number for  the User.  This ID number will be used to 
ident ify the user when check ing in and ou t tools. 

Nam e   Enter  the Name of the User. 

Address  Enter  the Address of the User. 

Phone   Enter  the phone number of the User. 

Fax   Enter  the fax number of the User. 

Em ai l  Address Enter  the email address of the User if applicable. 

Supervi sor   Enter  the User ’s Supervisor  if applicable. 

 

 

Si t e Li st  
The Site List  is a simple list  of the job sites, satell ite offices, or  other  places where tools are 
assigned.  An example of the Site List  screen is shown in figu re 5.  To add a new User press the 
“+” symbol and fi l l  in  the appropr iate fields.  The Site List  fields are explained below figu re 5. 
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Figu re 5 

 

Si t e ID  A unique ID number for  the Site.  Th is ID number will be used to ident ify 
the site when check ing in and ou t tools. 

Nam e   Enter  the Name of the Site. 

Address  Enter  the Address of the Site. 

Phone   Enter  the phone number of the Site. 

Fax   Enter  the fax number of the Site. 

Em ai l  Address Enter  the email address of the Site if applicable. 

Supervi sor   Enter  the Site Supervisor  if applicable. 

Tool  K i t  
Tool Kits are collect ions of tools that may be treated as a single unit .  An example of the Tool 
Kits screen is shown in figu re 6.  To add a new Tool Kit  press the “+” symbol and fi l l  in  the 
appropr iate fields.  The Tool Kit  fields are explained below figu re 6. 

 



 

Landm ark  Dat a Syst em s, Inc. Sm al l  Tool  Track i ng Im plem ent at i on  Task s  ····   19 

 
Figure 6 

 

K i t  ID  A unique ID number for  the Kit .  This ID number will be used to ident ify 
the Kit  when check ing in and ou t tools. 

 

Class ID Select  the k it  class from the previously entered list  by click ing on the 
down arrow at  the r ight  of the entry box. 

Bar  Code ID This is an opt ional field for  use with the Bar Code scanning featu re of the 
program.  Enter  a unique Bar Code number either  by manually typing 
the Bar Code number or by select ing the field and then scanning the Bar 
Code with the Bar Code Scanner.  This ID number will be used to ident ify 
the tool when check ing in and ou t tools.   

 
Descr i pt i on   Enter  a descr ipt ion of the tool k it . 
 
Not es Make notes here abou t the tool k it .  These may be updated per iodically to 

bu ild a diary of in format ion abou t the tool k it . 
 
Load Pi ct ure This bu tton allows you  to add a pictu re of the tool k it  for  easier  

ident ificat ion.  After  click ing th is bu tton a window will open allowing you  
to browse to the pictu re fi le on your computer  or  at tached device.  The 
fi le types must be either  a jpeg or  a bitmap image. 

 

K i t  Assi gnm ent s 
After  creat ing the tool k its you  must use the Kit  Assignment tab to assign tools to the k its.  An 
example of the Kit  Assignments screen is shown in figu re 7.  To assign a tool to a tool k it  first  
select  the tool k it  in  the upper left  window.  The available tools not already assigned to a tool 
k it  wil l appear in the r ight  window.  Select  the tool you  wou ld like to add and a press the left  
arrow bu tton beside the bottom left  window. To select  mu lt iple tools hold the Ctr l key and 
select  your tools.  The tool wil l then appear in the bottom left  window and will be a par t  of that  
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tool k it .  To remove a tool from a tool k it  select  the tool in  the bottom left  window that you  wish 
to remove and press the r ight  ar row bu tton next to the bottom left  window.  The tool wil l then 
appear in the tool l ist  in  the r ight  window and will no longer be a part  of the tool k it . 

 
Figure 7 
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Dai ly  Operat i ons 

Open Com pany  
 

The Open Company screen appears when you  first  open the Small Tool Track ing Program.  
This screen allows you  to select  a company to open and choose your User ID.  If you  have only 
a single company and only one user that  does not have a password setup the Open Company 
screen will not  appear.  Once you  are in the program you  can also switch companies by 
click ing File and then Open Company.  The Open Company screen will appear allowing you  to 
change companies or  change users.   

 

 

Check ing out  t ools and k i t s 
 

To check  ou t or  assign a tool or  tool k it , follow the steps ou t lined below.  The User List , Class 
List  and Tool List  must be entered pr ior  to using the Check  Ou t rou t ine. 
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St ep 1:  Select  a date.  Use the down arrow at  the r ight  of the entry field to display a calendar 
from which you  may pick  a date.   
 
St ep 2:  Select  a user.  Click  on the down arrow at  the r ight  of the entry field to br ing up a list  
of users from which to choose.  You  must pick  a valid user from the list .  If the user is not in 
the list , click  on Master Lists to add the user. 
 
St ep 3:  Select  a tool by click ing on a tool or  tool k it  in  the list .  Tools that  are assigned to a 
tool k it  and unavailable tools will not  appear in th is l ist .  To select  mu lt iple tools hold the Ctr l 
key and select  your tools.  To scroll down in the list , use the scroll bar  at  the r ight  of the gr id or  
the Page Down key on your keyboard.  You  may change the sor t  order of the list  by click ing on 
the appropr iate heading.  To view the list  by user, click  on the word USER in the t it le.  
Likewise, you  may click  on TOOL or  CLASS to sor t  the list  by tool or  class, respect ively. 
 
To select  a tool by bar  code, simply scan the bar code while th is screen is open.  The scanner 
will find and highlight  the tool in  the Tool List  just  as if you  had selected it  with the mouse.  
You  may scan several tools pr ior  to check  ou t. 
 
You  may view a list  of tools that  are assigned to cer tain sites or  view the ent ire l ist  of tools or  
tool k its.  Click  on the drop down arrow at  the r ight  of the Select  a Site entry field to br ing up a 
list  of sites from which to choose.  You  must pick  a valid site from the list  or  select  the all tool 
category.  If the site is not in the list , click  on the Master  Lists to add the site.  Assigning tools 
to a site will be explained fu r ther  later  in th is documentat ion. 
 
St ep 4:  Click  on the Check  Ou t bu tton to save the assignment.  You  will be prompted with a 
confirmat ion quest ion at  which t ime you  may abort  the assignment. 
 

Using the Opt ions bu tton on the Task  Bar, you  may choose to pr int  a receipt  of the Check  Ou t 
act ivity. 

 



 

Landm ark  Dat a Syst em s, Inc. Sm al l  Tool  Track i ng Dai ly  Operat i ons  ····   23 

Check ing i n  t ools and k i t s 
 
To check  in a tool or  tool k it , follow the steps ou t lined below.  The User List , Class List  and Tool 
List  must be entered pr ior  to using the Check  In rou t ine. 
 

 
 
St ep 1:  Select  a date.  Use the down arrow at  the r ight  of the entry field to display a calendar 
from which you  may pick  a date.   
 
St ep 2:  Select  a tool by click ing on a tool or  tool k it  in  the list .  Only tools that  are checked ou t 
are displayed in th is l ist .  To select  mu lt iple tools hold the Ctr l key and select  your tools.  To 
scroll down in the list , use the scroll bar  at  the r ight  of the gr id or  the Page Down key on your 
keyboard.  You  may change the sor t  order of the list  by click ing on the appropr iate heading.  To 
view the list  by user, click  on the word USER in the t it le.  Likewise, you  may click  on TOOL or  
CLASS to sor t  the list  by tool or  class, respect ively. 
 
To select  a tool by bar  code, simply scan the bar code while th is screen is open.  The scanner 
will find and highlight  the tool in  the Tool List  just  as if you  had selected it  with the mouse.  
You  may scan several tools pr ior  to check  ou t. 
 
St ep 3:  Click  on the Check  In bu tton to save the assignment.  You  will be prompted with a 
confirmat ion quest ion at  which t ime you  may abort  the assignment. 
 

Using the Opt ions bu tton on the Task  Bar, you  may choose to pr int  a receipt  of the Check  In 
act ivity. 
 

Assign ing t ools and k i t s t o si t es 
 
To assign a tool or  tool k it  to a site, follow the steps ou t lined below.  The User List , Class List , 
Tool List , and Site List  must be entered pr ior  to assigning tools to a site. 
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St ep 1:  Select  a date.  Use the down arrow at  the r ight  of the entry field to display a calendar 
from which you  may pick  a date.   
 
St ep 2:  Select  a site.  Click  on the down arrow at  the r ight  of the entry field to br ing up a list  
of sites from which to choose.  You  must pick  a valid site from the list .  If the site is not in the 
list , click  on Master  Lists to add the site. 
 
St ep 3:  Select  a tool by click ing on a tool or  tool k it  in  the list .  To select mu lt iple tools hold 
the Ctr l key and select  your tools.  To scroll down in the list , use the scroll bar  at  the r ight  of 
the gr id or  the Page Down key on your keyboard.  You  may change the sor t  order of the list  by 
click ing on the appropr iate heading.  To view the list  by user, click  on the word USER in the 
t it le.  Likewise, you  may click  on TOOL or  CLASS to sor t  the list  by tool or  class, respect ively. 
 
To select  a tool by bar  code, simply scan the bar code while th is screen is open.  The scanner 
will find and highlight  the tool in  the Tool List  just  as if you  had selected it  with the mouse.  
You  may scan several tools pr ior  to check  ou t. 
 
St ep 4:  Click  on the Assign bu tton to save the assignment.  You  will be prompted with a 
confirmat ion quest ion at  which t ime you  may abort  the assignment. 
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Repor t s 

Inqui ry  by  Tool  
 

The “By Tool” window under the Details/ History tab displays informat ion on tools and the 
history of the tool assignment.  Click  on a tool in the upper left  gr id to display cu rrent 
informat ion abou t the tool and the history of assignments. 
 
You  may sor t  the tool gr id by USER, TOOL, CLASS or SITE by click ing on the appropr iate t it le 
in the tool gr id.  This may make it  easier  for  you  to find a par t icu lar  tool.  Addit ionally, a search 
dialog featu re can be found at  the top r ight  of the tool l ist  to help locate tools. 
 
To pr int  a report  of the Tools l isted by class, simply click  on the Pr int  bu t ton to the r ight .  A 
window will pop up giving you  a chance to choose which classes you  wou ld like to pr int  or  the 
defau lt  which is all the classes.   
 
After  select ing a tool you  can also add, edit  or  view the Repair / Maintenance informat ion for  
that  tool by click ing on the Repair / Maintenance tab.  You  may also pr int  a 
Repair / Maintenance history by click ing on the Pr int  bu t ton on the r ight  of the screen.  A 
window will pop up allowing you  to select  a par t icu lar  tool, group of tools, or  the ent ire l ist  of 
tools.  The defau lt  is the tool you  have selected.   

 

Inqui ry  by  User  
 
This opt ion allows you  to display the tools assigned to a par t icu lar  user and to review the tool 
h istory.  Click  on the user in the upper left  gr id and the tools assigned to the user will be 
displayed in the lower left  gr id.  The history on the tool selected in the lower left  gr id will be 
displayed in the r ight  gr id. 
 
You  have three pr int  opt ions: 
 
En t i re Li st    Pr ints a report  of each user and the tools that  are cu rrent ly checked ou t 

to the user. 
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Users On ly    Pr ints a report  of tools checked ou t to the user you  select  in the Select  
User gr id. 

 
Unassigned   Pr ints a report  of all tools that  are not assigned to a user. 

 

Viewing t he Act i v i t y  Log 
 
This report  displays the complete l ist ing of tool assignments in it ially sor ted by checkou t date.  
You  may display the list  sor ted by user, tool, check  ou t date, or  class simply by click ing on the 
USER, TOOL, CHECK OUT, or  CLASS name in the gr id t it le. 
 
Addit ionally, you  may select  por t ions of the log by using the Opt ions bu tton to the r ight  to 
select  for  a single user, a single tool or  a range of dates. 
 
Pr int  the Act ivity Log by select ing the Pr int  bu t ton to the r ight . 

 

Repor t s Menu 
 
The Reports Menu  contains opt ions to review data on tools, users or  assignment act ivity.  Each 
report  allows you  to sor t  or  select  data and display the informat ion on the screen with pr int  
opt ions.  The different reports that  can be run from the Reports Menu  will be explained below. 
 

Tool  Li st s 
 
The Tool Lists sect ion of the Reports Menu  allows you  to select  between fou r  different ways to 
view data on you  list  of tools.  Below are the fou r  opt ions under the Tool Lists and a br ief 
descr ipt ion of each. 

Tool  Li st  This opt ion allows you  to pr int  a report  of the ent ire tool l ist  or  a specific 
sect ion of the tool l ist .  You  can also sor t  the list  in  a var iety of ways.  
When you  select  th is opt ion a window will pop up allowing you  to 
customize the report .  Use the drop down arrows next to the select ion 
field to select  which field you  need.  Then use the drop down arrow to 
select  which field you  wou ld like to use to select  the tools to report .  Once 
you  have selected your field, use the drop down arrows to choose the 
range of tools you  desire.  After  you  have made your select ions press the 
“Pr int  It ” bu t ton to display the resu lts of you r report .  You  may pr int  th is 
resu lt  screen by select ing the pr int  bu t ton in the top left  hand corner of 
the report .   

 
By  User  This opt ion allows you  to display the tools assigned to a par t icu lar  user 

and to review the tool h istory.  Click  on the user in the upper left  gr id 
and the tools assigned to the user will be displayed in the lower left  gr id.  
The history on the tool selected in the lower left  gr id will be displayed in 
the r ight  gr id. 

 
You  have three pr int  opt ions: 
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En t i re Li st    Pr ints a report  of each user and the tools that  are 

cu rrent ly checked ou t to the user. 
Users On ly    Pr ints a report  of tools checked ou t to the user you  select  

in the Select User gr id. 

Unassigned   Pr ints a report  of all tools that  are not assigned to a user 

 
By  Tool  The “By Tool” window under the Details/ History tab displays informat ion 

on tools and the history of the tool assignment.  Click  on a tool in  the 
upper left  gr id to display cu rrent informat ion abou t the tool and the 
history of assignments. 

   
To pr int  a report  of the Tools l isted by class, simply click  on the Pr int  
bu t ton to the r ight .  A window will pop up giving you  a chance to choose 
which classes you  wou ld like to pr int  or  the defau lt  which is all the 
classes.   

 

After  select ing a tool you  can also add, edit  or  view the 
Repair / Maintenance informat ion for that  tool by click ing on the 
Repair / Maintenance tab.  You  may also pr int  a Repair / Maintenance 
history by click ing on the Pr int  bu t ton on the r ight  of the screen.  A 
window will pop up allowing you  to select  a par t icu lar  tool, group of 
tools, or  the ent ire l ist  of tools.  The defau lt  is the tool you  have selected. 

 

By  Si t e This opt ion allows you  to pr int  the list  of tools assigned to each site.  
When you  select  th is opt ion a window will pop up allowing you  to 
customize the report .  Use the drop down arrow to select  the beginning 
site for  the report .  Then use the second drop down arrow to select  the 
ending site for  the report .  If you  wou ld like run a report  on just  one site 
select  that  site for  the beginning and ending sites.  After  you  have made 
your select ions press the “Pr int  It ” bu t ton to display the resu lts of you r 
report .  You  may pr int  th is resu lt  screen by select ing the pr int  bu t ton in 
the top left  hand corner of the report .   

Act i v i t y  Log 
 
This report  displays the complete l ist ing of tool assignments in it ially sor ted by checkou t date.  
You  may display the list  sor ted by user, tool, check  ou t date, or  class simply by click ing on the 
USER, TOOL, CHECK OUT, or  CLASS name in the gr id t it le.  
 
Addit ionally, you  may select  por t ions of the log by using the Opt ions bu tton to the r ight  to 
select  for  a single user, a single tool or  a range of dates. 
 

Pr int  the Act ivity Log by select ing the Pr int  bu t ton to the r ight . 

Due Dat e Repor t  

This opt ion allows you  to pr int  a l ist  of tools based on the date they are due to be checked in.  
When you  select  th is opt ion a window will pop up allowing you  to customize the date range for  
the report .  Use the drop down arrows next to the select ion field to select  a beginning date and 
an ending date for  the range.  After  you  have made your select ions press the “Pr int  It ” bu t ton to 
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display the resu lts of you r report .  You  may pr int  th is resu lt  screen by select ing the pr int  
bu t ton in the top left  hand corner of the report .    

Repai r  Hi st ory  

This opt ion allows you  to pr int  a repair  h istory report  of the tool l ist  or  a specific sect ion of the 
tool l ist .  When you  select  th is opt ion a window will pop up allowing you  to customize the 
report .  Use the drop down arrows to choose a range of tools.  The defau lt  is set  to run a report  
on the ent ire tool l ist .  After  you  have made your select ions press the “Pr int  It ” bu t ton to 
display the resu lts of you r report .  You  may pr int  th is resu lt  screen by select ing the pr int  
bu t ton in the top left  hand corner of the report .   

Unavai lable Tool  Repor t  

This opt ion allows you  to pr int  a l ist  of unavailable tools based on the class type.  Tools that  
have a Status set  to anything other than available will appear in th is report .  When you  select  
th is opt ion a window will pop up allowing you  to customize the report .  Use the drop down 
arrows to choose the range of classes you  wish.  The defau lt  is set  to run a report  on the ent ire 
Class List .  After  you  have made your select ions press the “Pr int  It ” bu t ton to display the 
resu lts of you r report .  You  may pr int  th is resu lt  screen by select ing the pr int  bu t ton in the top 
left  hand corner of the report . 

Inven t ory  I t em s 

This opt ion allows you  to pr int  a l ist  of inventory items and the amounts you  have in stock .  
When you  select  th is opt ion a window will pop up allowing you  to customize the report .  Use 
the drop down arrows to choose the range of classes you  wish.  The defau lt  is set  to run a 
report  on the ent ire Class List .  After  you  have made your select ions press the “Pr int  It ” bu t ton 
to display the resu lts of you r report .  You  may pr int  th is resu lt  screen by select ing the pr int  
bu t ton in the top left  hand corner of the report .
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Ut i l i t i es 

Back ing up t he Dat abase 
 
Back ing up your database is the process of saving a copy of your Small Tool data fi les on CDs, 
zip disks, or other  storage mediums.  If you r computer ’s hard disk  is backed up through a 
network  server  or  by some other means, you  may prefer  to back  up the database on your 
computer ’s C dr ive.   
 
Daily backup is the only way to protect  your company from the catastrophic loss of data that  
can resu lt  from computer  failu re.  If you  exper ience data loss, technicians at  Landmark  can 
replace your programs and your or iginal database, bu t it  wil l be impossible for  them to recreate 
your modified database if you  have not backed it  up. 
 
Back ing up is a simple process, and it  shou ld become a daily process that shou ld never be 
ignored.  It  shou ld become as much of a habit  as tu rning on and off your computer  each day. 
 
In order to have extra copies of your database (in case a copy is destroyed), back  up using 
three zip disks or  CDs.  Label them A, B, and C and use the oldest set  each t ime you  backup. 
 
To back  up your database, click  on the DB Backup bu tton under the File Menu .  After  select ing 
DB Backup a window will appear allowing you  to select  your Backup locat ion.  Type the 
database fi le dest inat ion path in the box provided or  press the “…” bu tton and browse to your 
database fi le dest inat ion.   Once you  have selected your dest inat ion press the “Backup” bu tton.  
A window will pop up let t ing you  know that your backup has completed successfu lly.  You  may 
also check  the locat ion you  backed up to and you  shou ld see two fi les.  One fi le is a text  
document named ST32.log and the other is a database fi le named ST32.db.   
 

Purging t he Hi st ory  Fi le 
 
As tools are checked ou t and passed from person to person, a h istory of tool assignments is 
created.  After  a per iod of t ime, you  may wish to pu rge a port ion of th is h istory. 
 
This may be done by select ing the Purge Tool History opt ion from the File Menu .  History 
records will be pu rged through the date indicated. 
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This in format ion doesn't  occupy a significant por t ion of the database, so if you  don't  reassign 
tools regu lar ly, thereby creat ing a large history, you  probably won't  need to pu rge often. 
 
Delet ing a tool au tomat ically pu rges the history for  that  tool. 

 

Expor t i ng a Repor t  t o a Fi le 
The Small Tool Track ing software gives you  the abil ity to export  a report  to several different 
types of fi le formats.  The following are the fi le types you  can export  to: Text File, PDF, Lotus, 
Quattro, Excel, HTML, and RTF.   
 
This may be done after  you  have made your select ion for  a report  and pressed the “Pr int  It ” 
bu t ton to display your resu lts.  Select  the pr int  bu t ton in the top left  hand corner of the report  
to display the pr int  opt ions.  Check  the “Pr int  to File” check  box at  the bottom of the screen.  
Then select  which fi le type you  wou ld like to export , select  the dest inat ion and fi le name, and 
click  OK.  The select ion of the pr inter  at  the top of the screen in not relevant when pr int ing to a 
fi le.     
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Appendi x A: Upgradi ng 

 
Upgrading Sm al l  Tool  Track ing Version  3.2 

In order to upgrade to Small Tool Track ing 4.0 you  must have Small Tool Track ing 3.2.0 or  
h igher installed.  If you  have an older  version contact  Landmark  Data Systems to pu rchase an 
upgrade to version 3.2.   

Do not  rem ove Sm al l  Tool  Track ing 3.2 before upgrading to version 4.0. 

1. Install Small Tool Track ing 4.0 – Follow direct ions to install you r configu rat ion of Small 
Tool Track ing. 

2. Import  3.2 Database – Open Small Tool Track ing 4.0, click  on File, and then Import  ver  
3.2.  Once the conversion window opens click  the import  bu t ton to begin convert ing 
your database.  The program will au tomat ically find your 3.2 database and then pop up 
a warning message.  Click  yes to proceed.  Once the blue progress bar reaches across 
scroll down to ensure the conversion is complete and then click  exit .  The import  screen 
will look  like the screen below when completed. 

 

3.  Check  Database – Restar t  the program and ensure your data has correct ly converted. 

4. Uninstall Small Tool Track ing Version 3.2 – Follow the direct ions below to uninstall 
you r configurat ion of Small Tool Track ing. 

Un inst al l i ng Sm al l  Tool  t rack ing Version  3.2 

Before performing the following tasks, make su re your data has been successfu lly converted to 
version 4.0 and you  have a backup of the version 3.2 database.  These tasks will delete your 
version 3.2 database. 

Un inst al l i ng Single Users and Net work  cl i en t s 



 

32  ····   Appendi x  B: Cust om  Repor t  Landm ark  Dat a Syst em s, Inc. Sm al l  Tool  Track i ng 

1. Shu tdown Interbase – Right click  on Interbase Guardian icon in the icon tray (lower 
r ight) and left  click  on shu tdown. 

2. Remove Small Tool Track ing – Go to the Control Panel and click  on Add/ Remove 
Programs, find Small Tool Track ing (not Small tool Track ing 4.0) and remove it . 

3. Run STREMOVE – Insert  the 4.0 version of Small Tool Track ing.  Exit  from the install 
screen; navigate to the CD’s u t i l i t ies directory and execu te the program 
STREMOVE.EXE.  Uncheck  the box “Save database to C:\ ” and click  “Do It ” and then 
Exit . 

4. Manually Delete, if necessary, the following… 

a. c:\ program files\  landmark  data systems\ st32 

b. c:\ program files\ landmark  data systems\ interbase 

c. Small Tool icon on the desk top (do not delete Small Tool Track ing 4.0 icon) 

 

Un inst al l i ng In t erbase Server  

1. If you  have a network  with Interbase running on a dedicated server , on the server , go to 
the Control Panel, Add/ Remove Programs and remove Interbase.  DO NOT do th is if you  
have other programs which use the Interbase database manager. 

2. Manually delete the folder  

c:\ program files\ landmark  data systems\ st32 

3. Perform the tasks above for  uninstalling network  clients on each workstat ion on which 
Small Tool Track ing 3.2 is loaded. 

 

Appendi x B: Cust om  Repor t  

In t roduct i on  
 
Welcome to Learning ReportBu ilder , a ser ies of tu tor ials developed to teach you  how to create 
custom reports. The tu tor ials will teach you  the basics of how to use the ReportBu ilder .  
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DESIGN  
The Report  Designer, pictu red above, is the applicat ion you  will use to bu ild reports. It  contains 
three workspaces: Data, Design, and Preview.  When first  displayed, the Report  Designer 
defau lts to the design workspace because th is is where you  will spend the major ity of you r 
report-bu ilding t ime. The design workspace is divided into two areas: the workbench and the 
canvas. The workbench is compr ised of toolbars, component palet tes, ru lers, and other tools 
that  can be used to manipu late the canvas. The canvas is the area that contains the report  
layou t. This is where the bands and components that  will u lt imately control the content of each 
page of the report  are placed. 
 
PREVIEW 
The preview tab plays an integral role in the report  creat ion process because it  allows you  to 
see how the report  wil l look  when pr inted. As you  work  through the tu tor ials, you 'l l not ice that 
th is workspace is frequent ly accessed so that you  can see how the report  is shaping up. You  
will make many changes and correct ions based on what is seen in th is workspace. The tools in 
th is space allow you  to view each page of the report  or  zoom in to get a better  look  at  a specific 
page. You  can also pr int  the report  from the preview workspace.   
 
DATA 
The data workspace is often the key to successfu l report  creat ion because it  allows the user to 
select  and manipu late the data needed for  a given report .  These tasks are accomplished via 
two visual tools: the Query Wizard and the Query Designer. These tools great ly simplify the 
often-difficu lt  task  of data select ion by giving us the abil ity to select  data withou t requ ir ing an 
in-depth knowledge of databases.  Once the data is selected, we can begin laying ou t the 
report . The pr imary pu rpose of a report  is to t ransform raw data into informat ion. The task  of 
report  bu ilders is essentially to make data meaningfu l.  The following tu tor ials will show you  
how to do just  that . 
 
ABOUT THIS BOOK 



 

34  ····   Appendi x  B: Cust om  Repor t  Landm ark  Dat a Syst em s, Inc. Sm al l  Tool  Track i ng 

As you  work  through th is gu ide, it  is important to keep in mind that the tu tor ials bu ild on one 
another.  Each tu tor ial produces some k ind of report  and br ings to l ight  important aspects of 
ReportBu ilder .   
 
A Quick Test Spin gives you  a glimpse of the Report  Designer 's report-bu ilding potent ial.   
 
Calisthenics offers a ser ies of exercises that prepare you  for  the tu tor ials. You  will be a n imble 
user when you  complete the calisthenics.   
 

The Summary Tutorial concentrates all that  you  learned in Calisthenics into a report .  

 

A Qui ck  Test  Spin  
 
OVERVIEW 
This simple exercise provides an introduct ion to the Report  Designer, the Query Wizard, and 
the process of bu ilding reports. The pu rpose of th is tu tor ial is to show you  what it  takes to 
bu ild a report , so if th is exercise starts to feel a l it t le over your head, don't  worry. We will cover 
the meaning behind the act ions in later  tu tor ials. The final report  for  th is tu tor ial shou ld 
contain the following items: 
•  A list  of Tool IDs 
•  The class that each tool belongs to 
•  A descr ipt ion for  each tool 
Not e: In order to follow along with th is tu tor ial you  need to select  company two for  the demo 
data.   
 
GETTING STARTED 
It  wil l be helpfu l for  you  to become familiar  with the following set of direct ions because you 'l l 
repeat th is process to begin each report .   
 

1. Click  the New Report  icon  on the main toolbar . 
2. Click  on the Data tab. 
3. Select  File |  New in order to access the New Items dialog. 
4. Double-click  on the Query Wizard icon. The Query Wizard will come up with a l ist  of 

Available Tables. 
 
QUERY WIZARD 
The Query Wizard is a tool that  allows you  to access informat ion from your database to use in 
your report . 
 

1. Choose the Tool l ist  Table by double-click ing on it . The Tool list  table shou ld now 
appear in the list  of Selected Tables. 

2. Once the Tool l ist  table is selected, click  the Next bu tton. 
3. Keep click ing the Next bu tton unt il you  reach the screen with the Set Order opt ion. 
4. Click  on the Set Order bu tton. 
5. Double-click  on Tool l ist .ToolID so it  appears in the list  of Selected Fields. 
6. Click  Fin ish. 
7. You 've officially completed your first  query via the Query Wizard. You 'l l not ice a new 

window in the upper left -hand corner of the data workspace.  This is a dataview . It  
represents the data, which is selected from the database each t ime the report  is 
generated. 
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8. Click  on the Design tab in order to begin laying ou t your report . 
 
DESIGN WORKSPACE 
The design workspace is the environment in which you  will bu ild reports.   Whatever you  pu t in 
the header band (the white space above the word 
'Header ') wil l appear at  the top of each page of the report ; whatever you  pu t in the detail band 
will be the body of the report , and whatever you  pu t in the footer  band will appear at  the 
bottom of each page of the report . 
 
Task  1 
Place and Name Labels 
 

1. Locate the label icon  on the toolbar . 
2. Click  on the icon. 
3. Click  in the white space of the header band in order to create a label. 
4. Repeat steps 1 through 3 to create two more labels in the header band. 
5. Select  'Label1'. 
6. Locate the edit  toolbar  (below the label component icon on the toolbar). It  shou ld 

contain the text  'Label1', which is the capt ion of the cu rrent ly selected label. 
7. Highlight  the text  in the edit  toolbar and type ToolID. 
8. Select  Label2 and type Class into the edit  toolbar . 
9. Select  Label3 and type Descr ipt ion into the edit  toolbar . 

 
Task  2 
Save the Report  
 

1. Press Ctr l + S to save your work . 
2. A dialog box will appear that  looks like th is: 
 

 
 

3. Expand the drop-down list  at  the top of th is dialog by click ing on the arrow icon. Select  
'All Folders' from the list . This will al low us to save the report  in  th is folder . 

4. At  the bottom of the dialog you  shou ld see an edit  box that contains the report  name. 
The defau lt  name is 'New Report .' Select  the text  and change the name to 'Qu ick  Tool 
List '. Click  the Save bu tton. 

5. Close the Report  Designer. Not ice that your new report  is l isted in 'All Folders'. 
6. Double-click  on Qu ick  Tool List  to retu rn to the design workspace. 

 
Task  3 
Bold the Text in the Labels 
 

1. Select  the ToolID label. 
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2. Hold down the Shift  key and then click  on the other two labels. All three labels shou ld 
now be selected. You  can tell that  they are selected by the small gray boxes su rrounding 
each label.  These boxes are called select ion handles. 
 

 
 

3. Click  the bold icon. All three label capt ions shou ld tu rn bold. 
 
Task  4 
Create and Choose Data for  DBText Components 
 

1. Locate the DBText icon  on the toolbar . 
2. Click  on the icon. 
3. Click  in the white space of the detail band in order to create a DBText component. 
4. Change the text  from bold to regu lar by click ing on the bold icon. 
5. Repeat steps 1 through 3 to create two more DBText Components in the header band. 
6. Select  DBText1. 
7. Not ice that there are two drop-down list  boxes in the upper left -hand corner of the 

Report  Designer.  The drop-down list  box on the left  contains the dataset from the 
dataview. The dropdown on the r ight  contains the fields. 

8. Select  'ToolID' from the drop-down list  box contain ing the fields.  
9. Select  DBText2. 
10. Choose 'ClassID' from the drop-down list .  
11. Select  DBText3. 
12. Choose 'Descr ipt ion ' from the drop-down list  box. 

 
Task  5 
Adjust  the Label Components 
 

1. Right-click  the 'ToolID' label and select  Posit ion. 
2. Set the left  to 0.1 and click  ‘OK’. 
3. Right-click  the ‘ClassID’ label and set the left  to 1.5 then click  ‘OK’. 
4. Set the ‘Descr ipt ion’ label left  to 3.0. 
5. Right-click  the 'ToolID' label and select  Posit ion. 
6. Set the ‘top to 0.3 and click  ‘OK’. 
7. Select  the 'ToolID' label. 
8. Hold down the Shift  key and click  on the other two labels.  All three labels shou ld now 

be selected. 
9. Launch the Align or  Space toolbar  by select ing View |  Toolbars and click ing on Align or  

Space.  The toolbar  shou ld appear under the drop-down list  boxes. 

10. Click  the Align Top icon .  The ‘ClassID’ and ‘Descr ipt ion’ labels shou ld align with 
the ‘ToolID’ label. 

 
Task  6 
Adjust  the DBText Components 
 

1. Right-click  the ‘ToolID’ DBText. 
2. Set the width to 1.3. 
3. Set the 'ClassID’ DBText width to 1.3. 
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4. Set the ‘Descr ipt ion’ DBText width to 3.0. 
5. Select  the ‘ToolID’ DBText and set the top to 0.0. 
6. Shift -click  the other DBTexts so that they are all selected. 

7. Click  the Align Top icon  on the Align or  Space toolbar . 
 

Not e: The DBText components may over lap.  That 's fine. The next task  will correct  the over lap. 
 
Task  7 
Align the Components 
 

1. Select  the ‘ToolID’ label and shift -click  the ‘ToolID’ DBText. 

2. Click  the Left  Align icon . The DBText component shou ld be posit ioned direct ly 
beneath the label and both components shou ld be aligned left . 

3. Left  align the ‘ClassID’ label and the ‘ClassID’ DBText. 
4. Left  align the ‘Descr ipt ion’ label and the ‘Descr ipt ion’ DBText. 
5. Press Ctr l + S to save your work . 

 
PREVIEW 
The preview window in the Report  Designer environment works the same way as the preview 
capability in other  Windows applicat ions: it  shows you  how your report  wil l look  when it  is 
pr inted.  
 

1. Click  on the Preview tab and look  at  your report . Make su re that the columns are 
spaced evenly with plenty of room for  long names. 

2. Everyth ing shou ld look  good except for  the rows, which are double-spaced. That  
spacing takes up too much room and will waste paper when the report  is pr inted. 

 
FIXES 
When you  preview a report , you 'l l undoubtedly find something that can be improved. Let 's fix 
the spacing. 
 

1. Retu rn to the design workspace by click ing on the Design tab. 
2. Place your cu rsor  over the gray bar labeled Detail. Your cu rsor  will change to an 

up/ down arrow, indicat ing that you  can drag the sect ion divider  up and down. 
3. Drag the divider  up unt il it  meets the bottom of the components in the detail band.   
4. Preview the report  once more. It  shou ld look  like th is: 
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5. Close the Report  Designer window by click ing the bu tton at  the upper r ight  corner of 
the window. 

6. A dialog box ask ing you  to 'Save Changes' wil l appear. Click  Yes. 
7. Congratu lat ions! You 've completed your first  ReportBu ilder  report . 

 

Cal i st hen i cs 
OVERVIEW 
These exercises will get  you  or iented in the Report  Designer environment and teach you  to use 
some basic tools. It 's a good idea to study th is sect ion because each task  is extremely detailed, 
whereas the other exercises will assume that you  are familiar  with the basics and therefore be 
less explicit . 
 
Not e: In order to follow along with th is tu tor ial you  need to select  company two for  the demo 
data. 
 
COMPONENT CREATION 
The first  th ing you  need to know in order to wr ite a report  is the significance of the canvas. The 
canvas is divided into sect ions called bands. A band is labeled in the sect ion divider 
immediately below it ; thus, the first  band is called the 'header ', the second is called the 'detail ', 
and the th ird is called the 'footer '. When the report  generates, the bands are pr inted on 
different par ts of the page. There are many different band types for  different occasions, bu t for  
now we'll just  use the header, detail, and footer  bands. 
 
Let 's create some components and pu t them in the bands. A component is an element used to 
control how the report  looks. Each component has a unique pu rpose. 
 

1. Click  the New Report  icon   on the main toolbar . The Report  Designer will appear 
with the design workspace act ive. 
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2. Click  the Label icon . 
3. Click  in the white space of the header band.  You 've just  created a label component. 
4. Repeat steps 2 and 3 to create two more labels in the header band. 

5. Locate the shape icon  on the toolbar . 
6. Click  the icon. 
7. Click  in the white space of the header band in order to create a shape. 
8. Press Ctr l + S to save your work . Name the report  Cal1. Save at  the end of each task . 

 
Not e: You  can use the process of click ing the icon, then click ing in a band to create any type of 
component. 
 
BAND ADJUSTMENT 
Not ice that the shape doesn't  qu ite fit  in  the header band. We can remedy th is by increasing 
the height of the band. 
 

1. Locate the ru ler  on the left  side of the workspace. 
2. Place your cu rsor  over the divider  labeled 'Header '. Your cu rsor  will change to an 

up/ down arrow, indicat ing that you  can drag the divider  up and down. 
3. Hold down the left  mouse bu tton and drag the divider  up and down. Notice the two lit t le 

l ines that appear on the ver t ical ru ler  to the left  of the divider . These lines are called 
guides because they represent the new posit ion of the divider . 

4. Increase the height of the header band by dragging the divider  unt il the gu ide reaches 
the one inch mark  on the ver t ical ru ler . In order to do th is you  must first  drag the 
divider  unt il the band height is greater  than one inch. Then release and drag the divider  
up unt il the top gu ide hits the one inch mark .   

 
Not e: This method of changing the size of the header band works for  all bands. 
 
BASIC COMPONENT SELECTION 
Once components are created, the real work  begins, for  each component needs to be carefu lly 
posit ioned in order to create a h igh-quality report . 
 

1. Select  the Label1 component by click ing on it .   
2. Select  the remaining components: hold down the Shift  key and then click  on the other 

two labels and the shape. All of the components shou ld now be selected. You  can tell 
that  they are selected by the small gray boxes su rrounding each component.  These 
boxes are called selection handles. 
 

 
 

3. Click  on the white space of the header band.  Not ice that the components are 
deselected. 

4. Click  on the white space to the left  of the first  label, hold down the left  mouse bu tton, 
and begin dragging the mouse down. A bounding box will appear.  

5. Drag the mouse across the components unt il the bounding box encompasses all of the 
components. 

6. Release the mouse bu tton. All of the components will be selected. 
7. Place your cu rsor  over one of the components and drag in any direct ion. Not ice how all 

of the components move in unison. This is called a component selection. 
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Not e: These are the two methods you  can use to select  mu lt iple components: the shif t-click 
method (hold down the Shift  key and click  the components) and the bounding box method (hold 
down the mouse bu tton and ou t line the components). 
 
DOCKING TOOLBARS 
Toolbars are used to set  the properties of a component.  Here are a few examples of the k inds of 
propert ies a component may have: font  size, color , and font style. Before we can use the 
toolbars effect ively, we must first  learn how to posit ion them with in the Report  Designer. 
 

1. Launch the Draw toolbar  by select ing View |  Toolbars and click ing on Draw. The 
toolbar  shou ld appear in the upper left -hand corner of the Report  Designer, above the 
hor izontal ru ler . 

2. Locate the handle  on the far  left  side of the toolbar . 
3. Place the cursor  over the handle and hold down the left  mouse bu tton. 

 

 
 

4. Drag the mouse down and to the left  unt il the rectangle pivots and appears as follows:  
 

 
 

5. Release the mouse bu tton. The toolbar  is now docked ver t ically. 
6. Drag the toolbar  over the upper left  corner of the header band.  
7. Release the handle. The toolbar  is now a floating w indow. The area at  the top of the 

toolbar  (labeled 'Draw') is called the title bar. You  can move the window by placing your 
cu rsor  over the t it le bar  and dragging. 
 

 
 

8. Click  on the close bu tton in the t it le bar . The toolbar  will be closed. 
9. Select  View |  Toolbars from the main menu  of the Report  Designer and click  on Draw 

menu  item. Not ice that the toolbar  retu rns to the same place it  was before you  closed it .   
 
Not e: When the toolbar  is a float ing window, you  can close the toolbar  by click ing the close 
bu tton.  You can always redisplay a toolbar  by accessing View |  Toolbars from the main menu . 
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10. Drag the toolbar  to the upper r ight  corner of the design workspace. 
11. Release the handle. The toolbar  is now docked hor izontally. 

 

 
 
Not e: All toolbars have the same dock ing abil ity as the Draw toolbar . 
 
SIZING, ALIGNING, AND POSITIONING COMPONENTS 
In order to get all of the components l ined up neat ly or  sized correct ly, you  must know how to 
size and align with dexter ity. 
 
Si zi ng 

1. Deselect  all components by click ing on the white space of the header band. 
2. Select  the shape component in the header band. 
3. Place your cu rsor  over the lit t le black  box on the r ight  side of the shape and wait  unt il 

the cu rsor  changes to a left / r ight  arrow. The lit t le black  boxes that su rround the shape 
are called sizing handles. 
 

 
 

4. Drag the cursor  to the r ight  and not ice how the shape gets wider. 
5. Place your cu rsor  over the sizing handle on the bottom of the shape and wait  for  the 

cu rsor  to change to an up/ down arrow. 
6. Drag the cursor  down and not ice how the label gets taller . 
7. Place your cu rsor  over the sizing handle on the r ight-hand corner of the shape and wait  

for  the cu rsor  to change to a diagonal arrow. 
8. Drag the cursor  diagonally.  The shape gets both wider and taller . 
9. Drag the shape to the left  corner of the header band. 
10. Move the shape up and down in the header band. Not ice the gu ides on the ver t ical and 

hor izontal ru lers. Whenever you  are dragging or  sizing, the gu ides show you  the 
posit ion and size of the select ion. 

11. Use the gu ides to set  the shape to ½ inch by ½ inch. The gu ides shou ld match up with 
the ½ inch mark  on both the hor izontal and vert ical ru lers.  

 
Not e: You  can also adjust  the size of a component by select ing the component, then holding 
down the Shift  key and pressing the arrow keys. You  can use th is method to size single and 
mu lt iple component select ions. 
 
Al i gn ing 

1. If the Align or  Space toolbar  is not already visible, launch it  by select ing View |  Toolbars 
and click ing on Align or  Space. The toolbar  shou ld appear above the hor izontal ru ler . 

2. Dock  the Align or  Space toolbar  on the left  side of the Report  Designer. 
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3. Select  the shape component in the header band. 
4. Hold down the Shift  key and then click  on the three labels. All fou r  components shou ld 

now be selected. 

5. Click  the Align Top icon  of the Align or  Space toolbar . The labels shou ld align with 
the shape. 

6. Deselect  the labels and select  only Label3.  Move Label3 to slight ly above the bottom of 
the header band. 
 

 
 

7. Select  Label3 and Shift -click  the other components in order to add them to the 
select ion. 

8. Click  the Align Bottom icon  of the Align or  Space toolbar . The components shou ld 
align with Label3. 

 
Not e: The first  component selected in a mu lt iselect  is the one to which the others align. 
 
Posi t i on i ng 

1. Deselect  the components by click ing in the white space of the header band. 
2. Select  the shape. 
3. Hold down the Ctr l key and press the up arrow several t imes to move the shape. 
4. As you  move the shape using th is method, look  at  the status bar in the lower left -hand 

corner of the Report  Designer. The Top measurement shou ld t rack  with the 
component 's locat ion. 
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5. Use the r ight  arrow key to move the shape to the r ight . The Left  measurement shou ld 
t rack  with the component 's locat ion. 

6. Posit ion the shape so that the Left  is 0 and the Top is 0.0625 
7. Deselect  the shape. 
8. Use the shift -click  method to select  the labels.   
9. Using the arrow keys, posit ion the select ion at  Left  of 1.3021 and a Top of 0.3854. 

 
FRONT-TO-BACK ORDER 
This sect ion il lustrates how a component can be used as a background for  other  components. 
 
Task  1 
Create and Color  Shapes 
 

1. Create two more shapes near the first  shape in the header band. 
2. Select  the first  shape. 

3. Locate the Fil l Color  icon  on the Draw toolbar . 
4. Click  the down arrow bu tton to the r ight  of the icon. The Fil l Color  palet te will be 

displayed. 
 

 
 

5. Select  yellow. 
6. Select  the second shape. 
7. Set the color to aqua. 
8. Select  the third shape. 
9. Set the color to pu rple. 

 
Task  2 
Over lap Shapes and Establish their  Order 
 

1. Posit ion the aqua shape so that its corner over laps the corner of the yellow shape. 
2. Posit ion the pu rple shape so that its corner over laps the corner of the aqua shape. The 

three shapes shou ld look  like th is: 
 

 
 

3. Select  the Preview tab. Not ice that the shapes retain their  front-to-back  order ing. 
4. Retu rn to the design workspace. 
5. Right-click  over the pu rple shape. 
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6. Select  the Send to Back menu  opt ion. Not ice how the pu rple shape is now behind the 
aqua shape. 
 

 
 

7. Right-click  over the pu rple shape. 
8. Select  the Br ing to Front menu  opt ion. The pu rple shape is once again in front  of the 

aqua shape. 
9. Right-click  over the yellow shape. 
10. Select  the Br ing to Front menu  opt ion. The yellow shape is now in front  of the other two 

shapes. 
 

 
 

11. Restore the or iginal order of the shapes by deciding which shape needs to be sent to the 
back  or  brought to the front. (Answer: Send the yellow shape to the back .) 

 
Task  3 
Use a Shape as a Background 
 

1. Right-click  over the yellow shape. 
2. Select  the ParentHeight menu  opt ion. The shape's height increases to match the band's 

height.  
 

 
 

3. Select  ParentWidth. The shape's width increases to match the band's width. The other 
components appear in front  of the shape because of the front-to-back  order. 

4. Right-click  over the yellow shape. 
5. Select  the Br ing to Front menu  opt ion. Not ice how all of the components disappear from 

view. 
6. Make the components reappear by r ight-click ing over the yellow shape and select ing the 

Send to Back  menu  opt ion. 
 
Not e: Whenever you  appear to have lost  a component, t ry using the Send to Back  method in 
order to find it : it  may be behind another component. 
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ADVANCED COMPONENT SELECTION 
This sect ion explains how to select  components in the foreground when you  have a larger 
component in the background. 
 

1. Try to select all of the components in the header band by click ing to the left  of the first  
component, holding down the left  mouse bu tton, and dragging the mouse (i.e. the 
bounding box method).  Not ice how the components cannot be selected.  This is 
because the yellow shape is selected and no bounding box can be drawn. 

2. Hold down the Ctr l key and try to select  the components using the bounding-box 
method again.  When the Ctr l key is held down, you  will see a bounding box. 

3. Expand the bounding box to encompass all of the components and release the mouse 
bu tton. All of the components, including the yellow shape, shou ld be selected. 

4. Try to move the selected components. Not ice how they appear to be locked in place. The 
select ion cannot be moved because the yellow shape fi l ls the band and has no where to 
go. 

5. Hold down the Shift  key and click  the yellow shape. 
 

Not e: You  can use the shift -click  method to deselect  any component that  is par t  of a mu lt i-
select ion. 
 
6. Move the selected components. The components can be moved now because the yellow 

shape is deselected. 
7. Try to deselect  the components by click ing on Label1. Nothing happens. That 's because 

you  must select  an unselected component or  click  in the white space of a band in order 
to clear  the cu rrent select ion.  

8. Deselect  the components by click ing on the yellow shape. 
 
ADVANCED SIZING 
When you  have a shape stretched using ParentWidth and ParentHeight, you  cannot change the 
size via the sizing handles. This exercise shows you  how to resize such a shape. 
 

1. Place your cu rsor  over the sizing handle on the left  side of the yellow shape. The 
left / r ight  arrow will be displayed. 

2. Try to reduce the size of the shape by dragging the cu rsor  toward the center  of the 
header band.  The shape can't  be modified because it  is set  to ParentWidth. 

3. Right-click  over the shape. 
4. Select  ParentWidth. The ParentWidth menu  opt ion is deselected. Now the shape's width 

can be modified using the sizing handle. 
5. Select  ParentHeight. The ParentHeight menu  opt ion is deselected. Now the shape's 

height can be modified using the sizing handles. 
6. Use the sizing handles to modify the yellow shape so that it  is abou t the same size as 

the other shapes. 
 
Not e: You  may not be able to resize the shape so that it  is exact ly the same size as the others. 
The next sect ion will address th is issue by showing you  a more precise way to resize shapes. 
 
SPEED MENU 
The speed menu appears when you  r ight-click  over a component. It  offers different opt ions for  
alter ing the overall look  of your component via changes in shape, size, and visibil ity. Here is 
the speed menu  for  a shape:  
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By now you  know abou t the following menu  opt ions: Br ing to Front, Send to Back , 
ParentHeight, and ParentWidth. Next, we'l l learn abou t the Posit ion opt ion, which will allow 
you  to control the size and posit ion of components more precisely. 
 
Task  1 
Set shape sizes 
 

1. Select  the labels and move them to the left  unt il they reach a left  of 3.7396 as indicated 
by the status bar. 

2. Access the speed menu  by r ight-click ing over the yellow shape. 
3. Select  Posit ion. . . . A dialog box like the one below will be displayed; however, the 

numbers may be slight ly different from these. That 's fine. 
 

 
 

4. Set the Left  to 2.0. 
5. Set the Top to 0.2. 
6. Set the Width to 0.5. 
7. Set the Height to 0.5. 

 
Task  2 
Resize the Aqua Shape 
 

1. Right-click  over the aqua shape to access the speed menu . 
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2. Select  Posit ion. . . . 
3. Set the Left  to 3.0. 
4. Set the Top to 0.2. 
5. Set the Width to 0.5. 
6. Set the Height to 0.5. The aqua shape shou ld now be the same size as the yellow shape. 
7. Set the Left  of the pu rple shape to 1. 
8. Set the Top to 0.3.  

Not e: The speed menu  applies only to the component over which you  have r ight  clicked, 
regardless of the select ion. Task  3 will i l lustrate th is aspect of the Report  Designer. 
 
Task  3 
Explore Component Propert ies and the RightClick  Opt ion 
 

1. Select  the aqua shape. 
2. Shift -click  the other two shapes in order to add them to the select ion. 
3. Right-click  over the aqua shape. 
4. Access the Posit ion . . . dialog. 
5. Set the Top to 0.1. Not ice that even though the other shapes are selected, the aqua 

shape is the only component that  moves. That 's because the aqua shape was the one 
over which we r ightclicked.   

6. Right-click  over the pu rple shape. 
7. Access the Posit ion. . . dialog and set the Top to 0.2. 
8. Right-click  over the yellow shape. 
9. Access the Posit ion. . . dialog and set the Top to 0.3.  
10. Right-click  once again over the aqua shape and set the top to 0.0. 

11. Click  the Align Top icon  on the Align or  Space toolbar . All shapes shou ld align with 
the top of the aqua shape because it  was selected first . 

 
Not e: You  can use th is method whenever you  need to set  the size or  posit ion of several 
components to the same value. 
 
Task  4 
Save Your Work  
 

1. Select  File |  Save from the main menu . 
2. Close the Report  Designer. 

 
DATA TREE 
The Data Tree allows you  to bu ild a report  based on data you  have selected from the database.  
In order to use the Data Tree, you  must first  select  data by creat ing a dataview. 
 
Task  1 
Create a New Report  
 

1. Click  the New Report  icon  on the main toolbar . 
2. Click  on the Data tab. 
3. Select  File |  New to access the New Items dialog. 
4. Double-click  on the Query Wizard icon. 

 
Task  2 
Create a Dataview Via the Query Wizard 
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1. The Query Wizard will come up with a l ist  of Available Tables. Choose the Tool List  table 
by double-click ing on it . The Tool List  table shou ld now appear in the list  of Selected 
Tables. 

2. Once the Tool List  table is selected, click  the Finish bu tton. 
3. You 'l l not ice a new window in the upper lefthand corner of the data workspace. This is 

the dataview.  It  represents the data that will be selected from the database each t ime 
the report  is generated.  In a later  exercise, we will show you how to make modificat ions 
to a dataview. For now, let 's move on to bu ilding the report . 

4. Click  on the Design tab in order to begin laying ou t your report . 
 
Task  3 
Dock  the Data Tree 
 

1. Maximize the Report  Designer window. 
2. Select  View |  Toolbars |  Align or  Space to h ide the Align or  Space toolbar . 
3. Select  View |  Toolbars |  Report  Tree to h ide the Report  Tree if it  is visible. 
4. Select  View |  Toolbars |  Data Tree from the main menu . 
5. Place your cu rsor  over the bottom of the Data Tree unt il the cu rsor  becomes an 

up/ down arrow. 
6. Hold down your left  mouse bu tton and drag the mouse down unt il you  can see all of the 

field names listed in the bottom part  of the Data Tree. 
7. Click  on the t it le bar  of the Data Tree and drag it  to the left , mak ing su re that the 

toolbar  is below the hor izontal ru ler .  
8. Release the mouse bu tton. The Data Tree shou ld dock  on the left  of the workspace like 

th is: 
 

 
 
Task  4 
Create a Vert ical Report  
 

1. Click  on the Layou t tab at  the bottom of the Data Tree. 
2. Select  the ver t ical style. 
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3. Click  on the Data tab at the bottom of the Data Tree. 
4. Click  the 'ToolID' field. 
5. Hold down the Ctr l key and click  the 'ClassID' field. Your select ion shou ld look  like th is: 

 

 
 

6. Locate the divider  labeled 'Detail ' on the canvas of the design workspace. 
7. Place your cu rsor  over the divider . Your cu rsor  shou ld change to an up/ down arrow, 

indicat ing that you  can drag the divider  up and down. 
8. Increase the height of the detail band by dragging the divider unt il the gu ide reaches 

the one inch mark  on the ver t ical ru ler . 
9. Posit ion your cu rsor  over the 'ToolID' field in the Data Tree and drag the select ion into 

the detail band. 
10. Release the mouse bu tton. The components necessary to display the 'ToolID' and 

'ClassID' fields in the report  are created. 
11. Click  on the Preview tab. Not ice how the labels repeat for  each row of the data. This is 

called a ver t ical report  because the components are laid ou t in a top-to-bottom fashion. 
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Task  5 
Create a Tabu lar  Report  
 

1. Retu rn to the design workspace. 
2. Select  all of the components created from the previous task  and press the delete key. 
3. Click  on the Layou t tab at  the bottom of the Data Tree. 
4. Select  the tabu lar  style. 

 

 
 

5. Click  on the Font icon for  Labels. 
6. A dialog box like th is will appear: 

 

 
 

7. Make the font style bold. Now any label created via the Data Tree will be bold. 
8. Click  the OK bu tton on the Font dialog. Not ice how the diagram at the top of the Data 

Tree reflects the change by bolding the word 'Company'. 
9. Click  on the Data tab at the bottom of the Data Tree. 
12. Click  the 'ToolID' field. 
10. Hold down the Ctr l key and click  the 'ClassID' field. 
11. Posit ion your cu rsor  over the 'ToolID' field in the Data Tree and drag the select ion into 

the lower left  corner of the header band. 
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12. Release the mouse bu tton. The components necessary to display the 'ToolID' and 
'ClassID’ fields are created. The labels are in the header band and the data is in the 
detail band. 
 

 
 

13. Click  on the Preview tab. Not ice how the labels appear only once at  the top of the page. 
This report  is 'tabu lar ' because the data is laid ou t in a left -to r ight  fash ion. 

 
Task  6 
Create a Tabu lar  Report  with a Gr id 
 

1. Retu rn to the design workspace and delete all of the components created in the 
previous task . 

2. Click  on the Layou t tab at  the bottom of the Data Tree. 
3. Click  the Grid check  box for  both Labels and Fields. 

 

 
 

4. Click  on the Data tab at the bottom of the Data Tree. 
5. Click  the 'ToolID' field. 
6. Hold down the Ctr l key and click  the 'ClassID' field. 
7. Posit ion your cu rsor  over the 'ToolID' field in the Data Tree and drag the select ion into 

the lower left  corner of the header band. 
8. Release the mouse bu tton. Not ice the boxes around the components. These shapes will 

give us the effect  of a gr id. 
9. Use the bounding box method to select  all of the components in the header band. 
10. Remove the labels from the select ion by holding down the Shift  key and click ing on each 

label.  Only the shapes shou ld now be selected. 

11. Locate the Fil l color  icon  on the Draw toolbar  and select  l ight  gray. 
12. Drag the divider  labeled 'Detail ' up unt il it  meets the bottom of the components in the 

detail band. 
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13. Click  on the Preview tab. Not ice the gr id effect . 
14. Save the report  as Cal2 and close the Report  Designer. 

 

Sum m ary  Tut or i al  
 
OVERVIEW 
This tu tor ial wil l solidify all of the report-bu ilding techniques you  learned in Calisthenics. The 
final report  shou ld contain the following items: 
•  A list  of Tool ID’s 
•  A list  of Class ID’s 
•  A list  of Vendor ’s 
•  A Descr ipt ion of the tools 
 
Not e: In order to follow along with th is tu tor ial you  need to select  company two for  the demo 
data.  
 
QUERY WIZARD 

1. Click  the New Report  icon  on the main toolbar . 
2. Click  on the Data tab. 
3. Select  File |  New in order to access the New Items dialog. 
4. Double-click  on the Query Wizard icon. The Query Wizard will come up with a l ist  of 

Available Tables. 
5. Choose the Tool List  table by double-click ing on it . The Tool List  table shou ld now 

appear in the list  of Selected Tables. 
6. Click  Fin ish. 
7. Access the design workspace. 

 
DESIGN WORKSPACE 
Task  1 
Launch the Data Tree and Set Propert ies 
 

1. If it  is not  already visible, launch the Data Tree toolbar . 
2. Dock  it  on the left  side of the workspace. 
3. Click  the layou t tab of the Data Tree. 
4. Set the Style to Tabu lar . 
5. Deselect  the Gr id boxes if they are checked. 
6. Click  the font icon for  Labels. 
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7. Set the Label font  to Ar ial, Bold, 10. 
8. Set the Field font  to Ar ial, Regu lar , 10. 
9. Click  on the data tab of the Data Tree. 
10. Press Ctr l + S to save your work . Save the report  as Summary Tu tor ial. Save at  the end 

of each task . 
 
Task  2 
Lay Ou t Components in the Detail Band 
 

1. Place your cu rsor  over the 'Detail ' divider . Your cu rsor  will change to an up/ down 
arrow, indicat ing that you  can drag the control up and down. 

2. Increase the height of the detail band by dragging the divider down unt il the gu ide 
reaches the one inch mark  on the ver t ical ru ler . 

3. Place a shape component in the detail band. 
4. Set the shape's fi l l  color  and line color  to yellow. 
5. Right-click  over the shape and select  ParentHeight and ParentWidth. 
6. Hold down the Ctr l key while you  select  the 'ToolID', 'ClassID', 'Vendor ', and 

'Descr ipt ion ' fields in the Data Tree. 
7. Drag the select ion from the Data Tree into the lower left  corner of the header band and 

release the mouse bu tton. Labels shou ld be created in the header band and DBTexts 
shou ld be created in the detail band. 

 

 
 
Task  3 
Posit ion the Components 
 

1. Posit ion the select ion so that the labels l ine up with the bottom of the header band. 
2. Deselect  the components by click ing on the white space of the footer  band. 
3. Select  all of the components in the detail band. 
4. Shift -click  the yellow shape to remove it  from the select ion. 
5. Drag the select ion up so that the components l ine up with the top of the detail band. 

The layou t shou ld look  like th is: 
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6. Deselect  the components. 
 
Task  4 
Size the Components 
 

1. Select  the ‘ClassID’ DBText component in the detail band. 
2. Use the sizing handle to make the component narrower. Size the component so that the 

gu ide lines up with the three inch mark  on the hor izontal ru ler . 
3. Shift -click  the Company label in the header band. 
4. Launch the Size toolbar . 

5. Locate the Shr ink  Width to Smallest  icon  and click  on it . The label's width shou ld 
shr ink  to match that of the DBText. 

 
Task  5 
Align the Components and Adjust  the Detail Band 
 

1. Select  the ‘Vendor ’ and ‘Descr ipt ion’ labels. 
2. Shift -click  the corresponding DBText components in the detail band. 
3. Drag the select ion unt il it  reaches the 3 1/ 8 inch mark  on the hor izontal ru ler . 
4. Left  just ify the DBText ‘ToolID’ component in the detail band. 
5. Drag the detail band divider  up unt il it  meets the bottom of the components. 

 
Task  6 
Lay Ou t the Footer  Band 
 

1. Click  the System Var iable icon . 
2. Click  the lower left  side of the footer  band. 
3. Select  Pr intDateTime from the drop-down list  box in the upper left  corner of the 

workspace. The date and t ime shou ld appear in the component. 
4. Place another system var iable component in the lower r ight  side of the footer  band. 
5. Select  PageNoDesc (Page Number Descr ipt ion) from the drop-down list  box. The page 

number shou ld appear in the component. 

6. Right just ify the system var iable by click ing the r ight-just ify icon . 
7. Align the tops of the system var iables. 
8. Press Ctr l + S to save your work .  

 
PREVIEW 
 

1. Click  on the Preview tab and look  at  your report . 
2. The data is solid yellow. Let 's pu t white spaces between the data in order to different iate 

the rows. 
 
FIXES 
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1. Click  the Design tab to retu rn to the design workspace. 
2. Right-click  over the yellow shape. 
3. Select  ParentHeight. 
4. Drag the detail band divider  down unt il you  can see a lit t le white space below the 

shape. The layou t shou ld look  like th is: 
 

 
 

5. Preview the report  once again. It  shou ld look  th is: 
 

 
 

6. Close the Report  Designer, saving the changes to the report . 
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